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Abstract This paper presents strengths and shortcomings of WinHex Specialist
Edition (version 11.25 SR-7) in the context of the overall digital forensics process,
focusing on its ability to preserve and examine data on storage media. No serious
problems were found during non-exhaustive testing of the tool’s ability to create a
forensic image of a disk, and to verify the integrity of an image. Generally accepted
data sets were used to test WinHex’s ability to reliably and accurately interpret file
dateetime stamps, recover deleted files, and search for keywords. The results of
these tests are summarized in this paper. Certain advanced examination capabilities
were also evaluated, including the creation of custom templates to interpret
EXT2/EXT3 file systems. Based on this review, several enhancements are proposed.
In addition to these results, this paper demonstrates a systematic approach to eval-
uating similar forensic tools.
ª 2004 Elsevier Ltd. All rights reserved.
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Introduction

WinHex began as a disk editing program and has
developed into a forensic tool that is useful to dig-
ital evidence examiners of all skill levels. Experi-
enced examiners use WinHex Specialist Edition to
validate the results of other tools and to perform
specialized tasks such as file comparison and text
extraction. This program is also used to teach novi-
ces about disk layout, file system structures, data
recovery, and other fundamental concepts in digi-
tal forensics. When a new tool emerges in this
field, it is necessary to assess its capabilities and
identify any weaknesses.
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When evaluating any forensic application, it is
important to measure its performance against gen-
erally accepted test data sets whenever feasible.
For this purpose, the Digital Investigation Tool
Test Images created by Brian Carrier were used
(publicly available at http://dftt.sourceforge.
net/). These data sets are designed specifically
to test a forensic tool’s ability to reliably and accu-
rately interpret file dateetime stamps, recover
deleted files, and search for keywords. When it is
not feasible to test a particular feature using ac-
cepted data sets, it is usually sufficient to validate
the results with other forensic tools to ensure they
are consistent or that any differences are explica-
ble. This validation approach was used during this
tool review to confirm that WinHex was capable of
making a forensic image of data on storage media,
calculating the MD5 hash value of a disk or image,
erved.

http://dftt.sourceforge.net/
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recovering deleted files, and correctly interpreting
various dateetime stamps embedded in different
file types. Based on this tool review and testing,
some future refinements are proposed to help
developers prioritize enhancements in the forensic
capabilities of WinHex.

In the process of reviewing WinHex, this paper
also familiarizes digital investigators with different
aspects of file systems as a source of evidence. The-
primary focus is on FAT and NTFS because these
are the file systems that WinHex directly supports.
Additionally, with the increasing use of UNIX sys-
tems on personal and corporate systems, digital in-
vestigators require a solid understanding of UNIX file
systems. Many people avoid this area because of the
misconception that it is beyond their technical abil-
ities. A secondary aim of this paper is to make UNIX
file systems more accessible by demonstrating how
WinHex can be used to examine EXT2 and EXT3 file
systems which are commonly found on Linux sys-
tems. This treatment helps novices who want to im-
prove their understanding of UNIX file systems in
a familiar Windows-based environment. This knowl-
edge is also useful to experienced practitioners who
examine UNIX systems with Windows-based tools
such as EnCase and FTK, enabling them to confirm
important findings at a low level using WinHex.

Preservation

Prior to making a forensic image of digital evidence
it is a good practice to create a sanitized storage
area. Using a storage area that has been wiped of
all previous data and verified to be empty prevents
the possibility of data from past investigations from
commingling with the current case. A selected disk
can be sanitized using WinHex’s Fill Disk Sectors op-
tion on the Edit menu. For the purpose of forensic
sterilization it is generally sufficient to overwrite
data once with a known pattern. WinHex permits
this type of wiping as well as the more rigorous ap-
proach recommended in USDOD (1995) to prevent
extraordinary hardware-based recovery efforts
(see Fig. 1). This author verified that WinHex suc-
cessfully filled all sectors as instructed after warn-
ing the user several times that all data on the disk
would be overwritten.

Additionally, prior to making a forensic image, it
is a good practice to calculate the cryptographic
checksum of the original disk. MD5 or SHA1 hash val-
ues of a disk are useful for verifying the integrity of
digital evidence by confirming that a forensic image
is identical to the original. The cryptographic check-
sum of a selected disk or file can be obtained using
WinHex’sCalculate Hash option on the Tools menu.

The WinHex Clone Disk option under the
ToolsdDisk Tools menu can be used to either clone
the source disk onto another disk, or copy all sec-
tors of a disk into a file as shown in Fig. 2. Before
using this feature, it is advisable to configure
WinHex to automatically calculate the MD5 value
of data that it copies by setting the Calculate
auto-hash to MD5 under the OptionsdSecurity
menu item. It is also advisable to run WinHex on
Windows 2000/XP when performing this operation
to ensure that the disk size is obtained using I/O
control codes (e.g., IOCTL_DISK_GET_LENGTH_
INFO) instead of relying on information provided
by the BIOS via the Int13h interface. Notably,
because WinHex does not send ATA commands
directly to the drive, it may not detect all sectors
that are hidden by a Host Protected Area (HPA) or
Device Configuration Overlay (DCO).

Testing performed by this author found that
WinHex copied all data from storage media, and
correctly calculated the MD5 values of storage
media and image files. However, error handling
during the acquisition process is lacking. For in-
stance, when saving an image file to a disk that
Figure 1 Sanitizing a disk using the ‘‘DoD’’ option of WinHex’s Fill Disk Sectors facility.
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Figure 2 Copying data in all sectors from a hard disk into a file.
was too small, WinHex aborted the acquisition pro-
cess after it had filled the destination disk, giving
an error that the disk was full. It would be more ef-
fective to inform the user from the outset that
there is insufficient space on the target disk, or
to prompt the user for additional storage when
the destination disk is full. Similarly, when trying
to clone a disk onto another disk that was too
small, WinHex generated an unspecified input er-
ror and aborted the operation. It would be more
helpful for WinHex to inform the user that the ca-
pacity of the destination drive was too small. Fur-
thermore, WinHex permitted the unwary user to
perform the dangerous operation of saving a foren-
sic image onto the same disk that was being
copied, thus overwriting unallocated space on
the evidentiary drive. The potential for such mis-
takes emphasizes the importance of using a
write-blocker and designing tools to only save
data to a disk that the user has specifically desig-
nated as writable.

Examination

The examination process involves data recovery,
harvesting, reduction, organization and searching
(Casey and Palmer, 2004). A thorough examination
results in all relevant data being organized and
presented in a manner that facilitates detailed
analysis. Each step in the examination process is
dealt with separately here.

To begin, it is common practice to obtain infor-
mation about the disk using the Media Details
Report option on WinHex’s Specialist menu as
shown here:

Using this feature, WinHex successfully detected
all six partitions in the Extended DOS Partition
Test (Carrier, 2003a).

Information in the Media Details Report can be
compared with parameters on the disk label,
CMOS settings, or with results from other tools to
confirm that the actual values were detected by
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Figure 3 Using WinHex’s Interpret Image File as Disk feature to examine a FAT file system and recover deleted files
and directories (disk image available at http://www.disclosedigital.com/downloads.html).
WinHex. In the event that a different disk ge-
ometry needs to be set, WinHex provides a Set
Disk Parameters option on the ToolsdDisk Tools
menu that can be used to specify different CHS
values when viewing a physical disk or a different
number of clusters when viewing a logical volume.

Recovery

In addition to examining active files, digital evi-
dence examiners often need to salvage deleted
data from a disk. WinHex can interpret FAT and
NTFS file systems and can automatically recover
deleted files and directories on these file systems.
In some instances, it is necessary to instruct
WinHex to parse the file system using the Interpret
Image File as Disk option on the Specialist menu.
Fig. 3 shows WinHex being used to recover the de-
leted file ‘‘greenfield.doc’’ and directory ‘‘april’’
from a FAT formatted disk.

Using the disk image from ‘‘FAT Undelete Test
#1’’ (Carrier, 2004a), WinHex successfully recon-
structed the directory structure and recovered
deleted files that were not fragmented.

When recovering deleted files on FAT file sys-
tems, WinHex assumes that data is located in con-
tiguous clusters. This assumption breaks down
when dealing with fragmented files such as those
in bold in Table 1, potentially causing clusters
from other files to be associated with the un-
deleted file. For comparison, this author used
WinHex and EnCase to recover 92 deleted photo-
graphs from a memory card. The MD5 hashes of the
files recovered using both tools were calculated
Table 1 WinHex results for ‘‘FAT Undelete Test #1’’ (Carrier, 2004a)

File Size MD5

#ing.dat 780 59b20779f69ff9f0ac5fcd2c38835a79
#rag1.dat 1584 c4f3b9a0f17d464f4fc61b94ecf6cc21
#rag2.dat 3873 965370acfa85aa7e26ab04bbd45cdcae
#ult1.dat 3801 ffd27bd782bdce67750b6b9ee069d2ef
#ir1\Mult2.dat 1715 59cf0e9cd107bc1e75afb7374f6e05bb
#ir1\Dir2\Frag3.dat 2027 a7a14ac62f79fdea4056ed5e8bcf97ef

http://www.disclosedigital.com/downloads.html
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using Maresware’s hash utility and then compared
using hashcmp as shown here:
This output indicates that there were differen-
ces between the same files recovered by both
toolsdthese mismatches were due to different re-
covery methods. When undeleting files, EnCase
skips clusters that are allocated to other files
whereas WinHex copies contiguous clusters, in-
cluding clusters that are allocated to active files.
The approach implemented by EnCase also breaks
down when portions of a deleted file are overwrit-
ten by another file that is subsequently deleted.
Ultimately, no single method will always be suc-
cessful in all circumstances. This emphasizes the
importance of using multiple tools and being aware
of the assumptions they make.

On NTFS, WinHex displays deleted files in the
context of the file system and, for convenience,
also assembles deleted files and directories that
are still referenced by the file system in an area
called ‘‘Lost & Found’’ as shown in Fig. 4.
Using the ‘‘NTFS Undelete (and leap year)
Test #1’’ (Carrier, 2004b), WinHex correctly dis-
played dates as 02/29/2004 and recovered all files
except the alternate data stream (ADS) associated
with file ‘‘mult1.dat’’ (see Table 2). Although
WinHex correctly associated the data in this ADS
with the parent file ‘‘mult1.dat’’, it did not provide
an automated way to recover the data in the
ADS. However, this alternate data stream was
detected using WinHex’s Create Drive Contents
Table feature with the ADS option enabled, and
the sectors associated with this ADS were listed
to help the examiner locate the associated data
on disk.

Although WinHex was able to recover ‘‘sing2.
dat’’da single cluster file in a directory whose
MFT entry had been reallocated, it was not
able to associate the file with its original directory.
Other specialized forensic tools including EnCase
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Figure 4 Using WinHex’s Interpret Image File as Disk feature to examine a NTFS file system and recover deleted files
and directories.
were similarly unable to associate this file with its
original directory.

Notably, when automatically interpreting file
systems, WinHex converts dateetime stamps to
the time zone of the examination system. There-
fore, examiners must be cognizant of this adjust-
ment as discussed in Boyd and Forster (2004).
The next section presents a number of other
ways that WinHex can be used to recover deleted
data.
Unallocated and file slack space

Keep in mind that criminals often take steps to
conceal their crimes, and deleted data often con-
tains the most incriminating digital evidence.
Therefore, it is often fruitful to scour unallocated
and file slack space for useful data. WinHex can be
used to recover both file slack and unallocated
space using the Gather Slack Space and Gather
Free Space options on the Specialist menu.
Table 2 WinHex results for ‘‘NTFS Undelete (and leap year) Test #1’’ (Carrier, 2004b)

File Size MD5

res1.dat 101 9036637712B491904CD0BFBDBE648453
sing1.dat 780 59B20779F69FF9F0AC5FCD2C38835A79
mult1.dat 3801 FFD27BD782BDCE67750B6B9EE069D2EF
mult1.dat:ADS Not recovered Not recovered
dir1\mult2.dat 1715 59CF0E9CD107BC1E75AFB7374F6E05BB
frag1.dat 1584 7A3BC5B763BEF201202108F4BA128149
frag2.dat 3873 0E80AB84EF0087E60DFC67B88A1CF13E
dir1\dir2\frag3.dat 2027 21121699487F3FBBDB9A4B3391B6D3E0
sing2.dat 1005 C229626F6A71B167AD7E50C4F2FCCDB1
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Figure 5 File carving based on class characteristics.
Furthermore, WinHex can extract the space that is
not assigned to any of the partitions on a disk if de-
sired using theGather Inter-partition Space option.

WinHex also has the capability to salvage deleted
files of a certain type from unallocated space. Fig. 5
shows the Recover File by Type feature on the
ToolsdDisk Tools menu being used to extract Word
documents from unallocated space. This approach
to salvaging files is commonly referred to as ‘‘file
carving’’ because it uses common header character-
istics to identify the beginning of a file and then
carves out the data in continuous clusters until it
reaches a characteristic that marks the end of the
file or until it reaches a predefined maximum file size.

By default, WinHex’s Recover File by Type
file carving feature only searches the beginning
of each cluster for headers. This approach is
efficient, taking advantage of the fact that files
usually start at cluster boundaries, but in some sit-
uations this assumption may not be suitable (e.g.,
when the desired files are embedded within other
files). Therefore, the ‘‘Thorough search’’ option in
Fig. 5 instructs WinHex to inspecting all data on
the disk for file headers, ignoring cluster and
sector boundaries. The results of this activity are
summarized in the following log that is automati-
cally generated by WinHex:

WinHex can also be used to recover files with spe-
cific patterns in their names using the Recover File
by Name feature on the ToolsdDisk Tools menu.

Deleted data can also be salvaged using
WinHex’s ‘‘template’’ feature. Users can create
customized templates that tell WinHex how to
interpret certain data structures. For example,
take a directory entry found in unallocated space
as shown here in hexadecimal:



Figure 6 Applying a template using the WinHex Template Manager.

a

b

Figure 7 (a) Applying the WinHex ‘‘FAT Directory Entry (Normal/short entry format)’’ template to a FAT directory
entry found in unallocated space. (b) Applying the WinHex ‘‘FAT Directory Entry (Long entry format)’’ template to
a FAT directory entry containing part of the filename ‘‘figure5-external-storage.tif’’.
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An examiner can view this directory in a more
readable form using a template packaged with
WinHex by placing the cursor at the beginning of
the data structure, opening the Template Manager
on the View menu, and applying the appropriate
template as shown in Fig. 6.

Using the WinHex templates for short and long
file names shown in Fig. 6 and applying them to
the appropriate directory entries results in the
interpreted data shown in Fig. 7.
recovery after a crash. Although WinHex does
not directly support the EXT2 and EXT3 file sys-
tems, individuals can create custom templates
to tell the program how to interpret any data
structure. Like FAT file systems, EXT2/EXT3 file
systems have a root directory and something like
a file allocate table; called the inode table. For
instance, the root directory of an EXT2 file sys-
tem is shown here in hexadecimal format with
inode numbers in bold:
Although the focus of this section was on
Windows systems, the file carving and template
features can be applied to other file systems such
as EXT2 and EXT3.

Extended file systems (EXT2/EXT3)

The EXT3 and EXT2 file systems are essentially
the same except that EXT3 has an additional
journal file that is used to expedite system
Using a WinHex template created by this author for
interpreting EXT2 root directory entries (available
at http://www.x-ways.net/winhex/templates/
index.html) enables us to view this information in
a more readable form as shown in Fig. 8.

The directory entry in Fig. 8 indicates that the
file ‘‘index.dat’’ is assigned inode 14. Using another
WinHex template created by this author for inter-
preting inode tables on EXT2/EXT3 systems enables
us to view the data in a more readable form as
shown in Fig. 9.

The inode shown in Fig. 9 indicates that the
file starts at block 577 and that indirect block
Figure 8 Using WinHex’s template feature to examine the Root directory of an EXT2 file system (disk image available
at http://www.disclosedigital.com/downloads.html).

http://www.x-ways.net/winhex/templates/index.html
http://www.x-ways.net/winhex/templates/index.html
http://www.disclosedigital.com/downloads.html
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Figure 9 Using WinHex’s template feature to examine an inode on an EXT2 file system (disk image available at
http://www.disclosedigital.com/downloads.html).
589 contains a list of additional blocks that are
assigned to this file. The contents of block 589
(589! 1024Z byte offset 603136) is shown here
in hexadecimal format.
blocks 590e625 (0000024Ed00000271 hexadeci-
mal). Once the data associated with a file has
been located, a WinHex template may be available
to interpret the data or the data can be marked in
This ‘‘alphabet soup’’ is simply a list of block
numbers in little endian format which equate to

WinHex and exported to a file for further process-
ing using other tools.

http://www.disclosedigital.com/downloads.html
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Although using templates to interpret file sys-
tems can be useful for certain tasks such as teach-
ing novices and verifying important details at a low
level, it is rarely feasible to perform a complete
forensic examination in this manner. On large disks
it would take an inordinate amount of time to
extract all data and metadata from the file sys-
tem using the techniques demonstrated in this
section.

Harvesting

The aim of harvesting during the forensic examina-
tion process is to gather metadata relating to
directories, files, and fragments salvaged during
the recovery process. File system characteristics
are the most common form of metadata. WinHex
can generate a list of existing and deleted files
and directories with associated characteristics, in-
cluding dateetime stamps, size, allocated clus-
ters, and hash values using the Create Drive
Contents Table option on the Specialist menu.

By default, the Create Drive Contents Table
feature lists active and deleted files that are still
referenced by the file system (i.e. in directories
on FAT and in the $MFT on NTFS). Enabling the
‘‘Particularly thorough search’’ option instructs
WinHex to look beyond the file system, and to me-
thodically scan the entire disk for deleted directo-
ries or MFT entries. Specifically, on FAT systems,
this thorough search feature searches the begin-
ning of every sector for the pattern generally asso-
ciated with a directory (‘‘. ..’’). According to the
developer, using the ‘‘Particularly thorough
search’’ option on NTFS causes WinHex to look
for the pattern generally associated with MFT
entries (‘‘FILE’’) at the beginning of each cluster
and at the beginning of each 1024-byte entity
within that cluster, if a cluster is larger than
1024 bytes. These facilities for generating a list
of deleted directory and MFT entries are useful
for verifying the results of other tools such as
EnCase’s Recover Folders feature.

By design, WinHex does not calculate hash
values of deleted files, making it necessary to save
the recovered files to disk and calculate their MD5
values with a tool specifically designed for this
purpose such as Maresware’s hash utility as
demonstrated in the recovery section of this
paper. This approach to calculating hash values is
recommended even when using integrated forensic
media examination applications since internal MD5
calculations may not always be correct.

After the basic file characteristics are har-
vested, it is then necessary to look within files
for additional metadata. Compound files such as
Microsoft Office and Outlook files have dateetime
stamps and other metadata embedded in them. As
noted earlier, custom WinHex templates can be
created to interpret different data structures. In
the case of index.dat and INFO files, WinHex can
invoke the X-Ways Trace utility on the Tools menu
to interpret the data as shown in Fig. 10.

Notably, the X-Ways Trace utility converts da-
teetime stamps into the local time zone of the ex-
amination computer when the Convert to Local
Time option on the Edit menu is enabled which
can create confusion if not realized (Boyd and
Forster, 2004).

The Data Interpreter feature on WinHex’s
Options menu can also be used to interpret embed-
ded dateetime stamps as shown in Fig. 11. Note
the discrepancy between the dateetime stamps
in Figs. 10 and 11 caused by the time zone ad-
justment (605CE7A27DEEC301 Z February 8, 2004
19:56:26 GMT).
Figure 10 An IE History index.dat file interpreted using X-Ways Trace (http://www.x-ways.net/trace/).

http://www.x-ways.net/trace/
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Figure 11 A Window 64 bit FILETIME dateetime stamp in an IE History (index.dat) file viewed using WinHex’s Data
Interpreter feature.
The Data Interpreter feature can convert
several time formats, including 64 bit Windows
FILETIME, 32 bit Windows/DOS, and UNIX datee
time stamps.

Search and organization

WinHex can search a disk for text or hexadecimal
values, allows for case sensitivity and Unicode
when performing text searches, and can be config-
ured with a wildcard character (e.g., ?, 3F), but
does not have a regular expression search feature.
In addition to searching for individual keywords,
a list of keywords can be provided in the Simulta-
neous Search feature on the Specialist menu and
the output can be saved to a file or to the WinHex
Position Manager which enables the user to locate
specific search hits on the disk. The output of the
Simultaneous Search feature includes the logical
file that contains the keyword but not the cluster
number. The cluster number and associated file
can be obtained by going to each keyword and
reading the information in the Details window as
shown in Fig. 12.

Using the disk image ‘‘NTFS Keyword Search #1’’
(Carrier, 2003b) shown in Fig. 12, WinHex located
all of the keywords except ‘‘n-frag’’ which was
split between two non-contiguous clusters in an
allocated file. The implication here is that WinHex
does not search the logical file system on the phys-
ical disk. For instance, in a homicide investigation,
if an incriminating file named ‘‘personal-diary.txt’’
contains the word ‘‘murdered’’ but this keyword is
split between two non-contiguous clusters, a key-
word search for ‘‘murdered’’ using WinHex will
not find this occurrence. Although WinHex can per-
form a logical search of a mounted volume using
the Open Folder option on the File menu, this
does not work with forensic images.
When a keyword is located in resident data
(keywords 1e4 in Table 3), search results exported
to a file or displayed in the Position Manager do not
clearly indicate the associated file name, simply
indicating that it was found in the MFT. To deter-
mine the file name it is necessary to place the cur-
sor on the keyword in WinHex and click on the
context sensitive Access button which will have
an option to recover the file associated with the
selected MFT entry as shown in Fig. 13. Notice
that the Details window shows the number of the
selected MFT entry.

Furthermore, for keywords in alternate data
streams, WinHex associated the hit with the
parent file or directory rather than with the ADS
(keywords 3, 4, 9 and 10 in Table 3). Omitting
the name of the ADS that contains a keyword could
lead to misinterpretations of the search results.
As an example, in a larceny investigation, if a file
named ‘‘personal-finances.txt’’ had an ADS named
‘‘stolen-money.txt’’ containing a list of stolen sums
of money, WinHex could be used to locate the list
of stolen money but would not show the examiner
that they were in the ADS named ‘‘stolen-money.
txt’’, instead displaying the name of the parent
file ‘‘personal-finances.txt’’.

Finally, WinHex did not recover the deleted file
named ‘‘file-n-2.dat’’ and therefore did not indi-
cate that the keyword ‘‘n-unalloc’’ was found in
this deleted file. Actually, it would be a surprise
if any tool could recover this file since the only ref-
erence to the filename is in the $Logfile and there
is no way to associate specific clusters with that
file name.

Be aware that WinHex does not provide the lo-
cation of keywords relative to the beginning of log-
ical files, only the offset from the beginning of the
disk.

Using the ‘‘FAT Keyword Search #1’’ (Carrier,
2003c), WinHex located all of the keywords in
the correct files except for those fragmented
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Figure 12 The Details window provides information about data at the current cursor position, including the cluster
and name of the associated file when applicable.
across non-contiguous clusters (in bold in Table 4).
Again, this indicates that WinHex only performs
a physical search of the disk and not a logical
search of files. The fact that WinHex found the
three ‘‘cross’’ strings indicates that it will find
strings that cross file boundaries. Specifically, it

Table 3 WinHex results for ‘‘NTFS Keyword Search
#1’’ (Carrier, 2003b)

Num String Cluster Cluster allocation

1 r-alloc 1342 ?:\$LogFile
r-alloc 5409 ?:\$MFT #27 (file-r-1.dat)

2 r-unalloc 1350 ?:\$LogFile
r-unalloc 1915 ?:\$LogFile
r-unalloc 5423 ?:\$MFT #34 (file-r-2.dat)

3 r-fads 1391 ?:\$LogFile
r-fads 5414 ?:\$MFT #29 (file-r-3.dat)

4 r-dads 1528 ?:\$LogFile
r-dads 5415 ?:\$MFT #30 (dir-r-4)

5 n-alloc 8050 ?:\file-n-1.dat
6 n-unalloc 8053 Unallocated space
7 n-frag Not found Not found
8 n-slack 8062 ?:\file-n-4.dat (slack)
9 n-fads 8067 ?:\file-n-5.dat (slack)
10 n-dads 8068 ?:\dir-n-6
will find keywords that start in a file and end in
slack space, start in one file and end in another,
and start in a file and end in an unallocated sector.

The Gather Text feature on the Specialist menu
is useful for extracting human readable data on
a disk. For instance, this feature can be applied
to unallocated or file slack space to find useful
text fragments. The Text Passages feature on the
Search menu performs searches for a specified
number of sequential letters, numbers, or punctu-
ation marks or spaces.

Conclusions and recommendations

WinHex Specialist Edition is a valuable tool for ex-
perienced forensic examiners to validate findings
obtained using other applications, and is useful
for students to learn about file systems and data
structures. In addition to most of the file inventory
and data recovery capabilities necessary in a foren-
sic examination tool, WinHex facilitates low-level
examination of digital evidence using the Data
Interpreter and template features. The template
feature can also be used to edit structures such as a
partition table or file allocation table, which can be



Tool reviewdWinHex 127
Figure 13 Displaying the file name associated with MFT entry #27 using WinHex’s context sensitive Access button
which facilitates the recovery of the associated file.
useful for repairing damage and recovering data.
A number of enhancements are proposed here to
address shortcomings described in this paper.

Preservation

One proposed enhancement to the Clone Disk fea-
ture is error handling to inform the user when the
destination disk has insufficient capacity. Alter-
nately, prompting the user for additional storage
when the destination drive is full would be an
effective way to respond to a full disk. It would

Table 4 WinHex results for ‘‘FAT Keyword Search
#1’’ (Carrier, 2003c)

Num String Cluster allocation Sector

1 first file1.dat 271
2 SECOND file2.dat 272

SECOND Root directory 239
3 1cross1 file1.dat 271
4 2cross2 file3.dat 273
5 3cross3 unallocated space 283
6 1slack1 file2.dat 272
7 2slack2 file3.dat 274
8 3slack3 file4.dat 277
9 1fragment1 Not found Not found
10 2fragment

sentence2
Not found Not found

11 deleted Unallocated space 276
12 a?b\c*d$e#f[g^ file7.dat 279
also be prudent to prevent a forensic image from
being saved to the same disk that it is being copied
from. One approach to preventing users from acci-
dentally overwriting evidence is to make all disks
read only by default and to require users to desig-
nate a disk as writable before WinHex will save
data onto it.

Since the testing in this review was not exhaus-
tive, the Clone Disk feature could benefit from
more testing to determine if it has problems under
certain circumstances. In any event, given the im-
portance of the acquisition process, it is advisable
to duplicate an evidentiary disk using at least two
tools and to verify that the MD5 value of both
images match that of the original.

Recovery

One issue uncovered while testing WinHex’s file re-
covery capabilities on FAT file systems was that
clusters allocated to active files were included in
undeleted files. Since there are advantages to dif-
ferent recovery methods, it would benefit the user
to have an option to choose which method to im-
plement. The method not currently employed by
WinHex is to skip allocated clusters during the un-
deletion process. Another proposed enhancement
is an automated feature to recover alternate data
streams.
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Search

One proposed enhancement to WinHex’s search
functionality is to perform both logical and physi-
cal searches of forensic images. A logical search
capability would enable WinHex to find keywords
that are fragmented across non-contiguous clus-
ters allocated to a file. A logical search would also
enable WinHex to calculate the offset of the key-
word from the beginning of the file.

When using the Simultaneous Search feature to
export search results to a file or WinHex’s Position
Manager, it would be helpful to include the file
name associated with resident data of MFT entries.
When a keyword is found in ADS, the search results
should provide the name of the stream in addition
to that of the parent file. Additionally, a regular
expression search feature would enable more flex-
ible searches.

Documentation

Although WinHex creates a log file when certain
actions are performed, it does not log all actions
that a forensic examiner takes. A log of an
examiner’s actions can help others assess the
work, reproduce the results, and determine if any-
one viewed private data without authorization or
exceeded their authorization by overstepping the
bounds of an organization’s privacy policy or a
search warrant. When using tools that do not cre-
ate this type of audit record, it is necessary to
make detailed written notes. Although it is always
a good practice to keep written notes when pro-
cessing evidence, they rarely have the level of
detail of computer generated audit logs.

Classification

Currently WinHex has limited data reduction capa-
bilities that could be improved by classifying files,
detecting file signature mismatches, and by using
the NSRL hash database to identify known files.
According to the developer, a WinHex Forensic
Edition will be available later this year that can
automatically classify files (e.g., Microsoft Office
documents, e-mail, images, pictures with a high
percentage of skin color) and detect file signature
mismatches.
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